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Introduction



1.1



1



Product Overview TM



GAUSS is a complete analysis environment suitable for performing quick calculations, complex analysis of millions of data points, or anything in between. Whether you are new to computerized analysis or a seasoned programmer, the GAUSS family of products combine to offer you an easy to learn environment that is powerful and versatile enough for virtually any numerical task. Since its introduction in 1984, GAUSS has been the standard for serious number crunching and complex modeling of large-scale data. Worldwide acceptance and use in government, industry, and the academic community is a firm testament to its power and versatility. The GAUSS System can be described several ways: It is an exceptionally efficient number cruncher, a comprehensive programming language, and an interactive analysis environment. GAUSS may be the only numerical tool you will ever need.
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1.2



Documentation Conventions



The following table describes how text formatting is used to identify GAUSS programming elements:
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Text Style



Use



Example



regular text



narrative



“... text formatting is used ...”



bold text



emphasis



“...not supported under UNIX.”



italic text



variables



“... If vnames is a string or has fewer elements than x has columns, it will be ...”



monospace



code example



if scalerr(cm); cm = inv(x); endif;



monospace



filename, path, etc.



“...is located in the examples subdirectory...”



monospace bold



reference to a GAUSS command or other programming element within a narrative paragraph



“...as explained under create...”



S C



reference to section of the manual



“...see O P, Section 7.7...”



2.1



2



Installation Under UNIX/Linux



1. Make a directory to install GAUSS in. 2. cd to that directory. 3. Gunzip the .gz file if there is one. 4. Untar the .tar file. 5. Run the executable script ginstall. 6. Put the installation directory in the executable path. 7. Put the installation directory in the shared library search path. 8. Install the license. (To receive a license and license installation instructions, email [email protected].)



For last-minute information, see README.term.
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Getting Started



Getting Started



GAUSS User Guide



2.2 2.2.1



Installation Under Windows Machine Requirements



• A Pentium or AMD computer or equivalent. • Operating System and Memory (RAM) requirements: – Windows XP, 256 MB minimum, 512 MB recommended. – Windows Vista 32-bit, 512 MB minimum, 1 GB recommended. – Windows Vista 64-bit, 1 GB minimum, 2 GB or more recommended. – Windows 7 32-bit, 1 GB minimum, 2 GB or more recommended. – Windows 7 64-bit, 2 GB minimum, 3 GB or more recommended. • Minimum of 100 MB free hard disk space, more may be needed depending on the size of matrices and the complexity of the program. • Monthly defragmenting is recommended.



2.2.2



Installation from Download



For download instructions, email [email protected].



2.2.3



Installation from CD



Insert the GAUSS compact disc into the CD-ROM drive, and setup should start automatically. If setup does not start automatically, browse to the CD-ROM drive, and double-click on the *.msi file to launch the installer. You can use this procedure for the initial installation of GAUSS, and for additions or modifications to GAUSS components. To receive a license and license installation instructions, email [email protected] and include your serial number and hostid.
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Page Organization Concept



The GAUSS graphical user interface is organized into separate “pages.” Pages are separate, customizable, main windows with their own set of widgets. Each page is designed to facilitate the performance of one of the common tasks performed in GAUSS: entering commands interactively, editing a program, examining data, debugging a program, and accessing the help system. Each page is a tab on the main application, allowing you to instantly access a window custom configured for the task you wish to perform. The GAUSS graphical user interface is composed of five different pages.



Command Page



For executing interactive commands.



Source Page



For editing program files.



Data Page



For examining and editing GAUSS matrices and other data.



Debug Page



For interactively debugging your programs.



Help Page



For accessing the GAUSS HTML help system.
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GUI Intro



3.1



3



GAUSS User Guide Each page may be undocked and from the main application and redocked by toggling the Dock button on the right side of the status bar. Navigation between undocked pages may be accomplished with ALT+TAB and ALT+SHIFT+TAB. To navigate between docked pages, use CTRL+TAB to cycle forward and CTRL+SHIFT+TAB to cycle backwards between pages. Each page has its own toolbars and menus. The menus and toolbars facilitate intuitive navigation through the GUI as well as performing desired functions. For example, clicking the New toolbar from any page in the GUI will bring the Source Page to the top of the window stack with a new file opened ready for editing. More details on navigating the GUI are in Section 4, N  GAUSS G U I.



3.2



Command Page



The Command Page is for entering interactive commands to GAUSS.



Figure 3.1: Command Page
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Menus and Toolbars



Command Page



File Menu



Tools Menu



Creates a new, untitled file in a programming editor on the Source Page.



Open



Opens an existing file in a programming editor on the Source Page.



Print



Prints selected text.



Print Setup



Specifies the printer to use and other options such as paper tray and page orientation.



Recent Files



Holds a selectable dropdown list of recently edited files.



Exit



Exits a GAUSS session.



Undo



Restores your last unsaved change.



Redo



Re-inserts changes removed with undo.



Cut



Removes selected text and copies it to the clipboard.



Copy



Copies selected text to the clipboard.



Paste



Copies the clipboard contents to the cursor position.



Preferences



Allows you to configure the GAUSS user environment.



Change Font



Allows you to specify a new font. Aptech recommends using a monospaced font such as Courier.



Change Working Directory



Allows you to browse for a new working directory.



Clear Working Directory History



Deletes the contents of your working directory history.



Recent Working Directories



Contains a dropdown list of your most recent working directories.



View Menu



The View menu lets you toggle on or off the windows on the current page.



Help Menu



Goto Help



Takes you to the Help Page.



About GAUSS



Provides information regarding your version of GAUSS.
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Edit Menu



New



GAUSS User Guide



New Print Open



Copy Cut



Paste



Figure 3.2: Command Page Toolbar



3.2.2



Command Page Toolbar



New



Opens a new, untitled document in a programming editor on the Source Page and brings you to the Source Page.



Open



Opens an existing file for editing.



Cut



Removes selected text and places it on the clipboard.



Copy



Copies selected text to the clipboard.



Paste



Copies the clipboard contents to the cursor position.



Print



Prints selected text.



Run



Runs the file at the top of the Action List.



Debug



Debugs the file at the top of the Action List.



Edit



Opens the file at the top of the Action List.



Stop Program



Stops a running GAUSS program.



3.2.3



Working Directory Toolbar



The Working Directory Toolbar contains a dropdown list that shows your current working directory and a history of recent directories. The Change Working Directory button allows you to browse for and select a new working directory.
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Current Working Directory Change Working Directory



3.2.4



GUI Intro



Figure 3.3: Working Directory Toolbar



Command History Toolbar



Search Run Previous



Paste Search Next Figure 3.4: Command History Toolbar



Run



Executes the highlighted command from the command history.



Paste



Pastes the highlighted command to the Command Input Window for further editing.



Search Previous



Searches the Command Output Window for previous executions of a command and its output.



Search Next



Searches the Command Output Window for the next execution of a command and its output.
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The Run, Debug, and Edit Buttons



Run



Debug



Edit



Stop



Figure 3.5: Run, Debug, and Edit Buttons



Immediately to the right of the Run, Debug, and Edit buttons is a downward pointing triangle. Clicking on this triangle reveals the Action List. The Action List is a selectable drop down list of your most recently acted upon files. The Run, Debug, and Edit buttons share the same Action List. You may add a file to the Action List by running it from the command line or while editing a file, click on the drop down menu from Run, Debug, or Edit, and select Current File. Clicking on the Run button will run the file on the top of the Action List. Placing your mouse over the Run Button produces a tooltip indicating which file will be run. To run one of the other files in the list, access the Action List by clicking on the triangle next to the Run button and select the name of the file you wish to run. The Debug and Edit buttons work in the same manner.



3.3



Layout



The Command Page contains four widgets: the Program Output Window, the Command History Window, the Command Input Window, and the Error Output Window. The Command Output Window shows the output from interactive commands and programs. It is also the location for user input requested by the GAUSS functions keyw and cons.
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Program Output Window Command History Window



Error Output Window



GUI Intro



Command Input Window



Figure 3.6: Command Page Widgets



3.3.1



Command History Window



The Command History Window contains a list of recently executed commands. Commands in the command history can be executed by double clicking them or highlighting a command and clicking the Run button from the Command History toolbar.



Commands can be sent to the Command Input Window for further editing before executing by highlighting a command and clicking the Paste button. The Search Next and Search Previous buttons will search the Command Output Window forward or backwards for previous executions of that command so that you may inspect its output.



To remove commands from the command history, right-click over a command and select Delete to remove only the highlighted command or Delete All to remove the entire contents of the command history.
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Paste Search Next Figure 3.7: Command History Window



3.3.2



The Command Input Window



The Command Input Window is where you enter interactive commands in GAUSS. The Command Input Window provides a command history with fully featured command line editing.



3.4



Command Line History and Command Line Editing



When you run a command at the GAUSS prompt, it is added to your command line history. The last 1,000 commands executed at the GAUSS command line are stored. The following keystrokes are supported for movement and editing at the command line and for retrieving the command line history:



3.4.1



Movement Left Arrow or CTRL+B
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Moves cursor left one character.



Introduction to the GAUSS Graphical User Interface Moves cursor right one character.



HOME



Moves cursor to beginning of line.



END or CTRL+E



Moves cursor to end of line.



ALT+Left Arrow or CTRL+Left Arrow



Moves cursor left one word.



ALT+Right Arrow or CTRL+Right Arrow



Moves cursor right one word.



Up Arrow



Search up through command history.



Down Arrow



Search down through command history.



GUI Intro



3.4.2



Right Arrow or CTRL+F



Error Output Window



The Error Output Window shows errors messages from program runs or interactive commands. It may be viewed from any page by clicking the Error Output button on the right side of the status bar.



3.5



Source Page: Editing Programs



The Source Page is for creating and editing programs and procedures.



3.5.1



Menus and Toolbars



Section 3.2 provides details of the main menus and toolbars. The Source Page contains the following additional menu options.
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Save



Saves the active file.



Save As



Saves the active file with a new or different file or path name.



Close



Closes the selected file.



Close All



Closes all open files.



Window Menu



Split Horizontally



Tiles any open programming editors horizontally.



Split Vertically



Tiles any open programming editors vertically.



Remove Split



Removes any editor window tiling.



Close



Closes the selected file.



Close All



Closes all open files.



3.5.2



Layout and Usage



The Source Page contains four separate window components.



Programming Editor



Individual programming editors are opened in the editor docking area. The editor docking area allows tabbing of multiple open files, with the option to tile editors with a horizontal or vertical split. Select Window->Split Horizontally or Window->Split Vertically to tile open editor windows.
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GUI Intro



Figure 3.8: Source Page



Figure 3.9: Programming Editor
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GAUSS User Guide Individual editor windows can be pulled out of the Source Page by grabbing their banner and dragging them to the desired location. Programming editor features:



1. Syntax highlighting: The GAUSS programming editor will provide syntax highlighting for GAUSS, C/C++, Java, Fortran, R and many other languages. 2. Autocompletion: Autocompletion is available in the GAUSS programming editor for GAUSS functions. Using autocomplete: if the characters you enter match items in the autocomplete list, a dropdown box will appear containing those functions. To navigate the dropdown list, press the down arrow or continue typing until only one selection remains. Once the desired command is highlighted, press the ENTER key to insert the remainder of the word.



Figure 3.10: Autocomplete



3. Tooltips: After a GAUSS command and an opening parenthesis has been entered, a tooltip will appear with the argument list for the function.



Figure 3.11: Tooltips



4. Code folding: At the start of code blocks (e.g., procedure definitions, do and for loops, and if statements), the left margin of the programming editor will contain a +. Clicking the + will hide the block of code from view and place a horizontal line across the editor indicating folded code and changing the + to a -. Clicking on the - will reveal the hidden code.
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Introduction to the GAUSS Graphical User Interface 5. Autoindenting: The GAUSS programming editor provides automatic code indenting and deindenting. Autoindenting not only simplifies the process of writing code but also encourages the creation of readable code.



6. Bookmarks: Bookmarks allow quick navigation to often visited lines of code. To insert a bookmark, hold down the SHIFT key and left click in the left margin of the file on the line where you would like to set the bookmark.



Double-click on a listed bookmark and GAUSS will bring you to the file and line of your bookmark regardless of whether the file is already open for editing or not.



Programming Editor Hot Keys CTRL+A



Select All.



CTRL+C



Copy.



CTRL+D



Debug current file.



CTRL+F



Find and replace.



CTRL+G



Go to Line.



CTRL+L



Delete line.



CTRL+N



Open new file.



CTRL+O



Open existing file.



CTRL+P



Print file.
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If a file contains more than one bookmark, you may use F2 to navigate to the next bookmark in the file. To navigate between bookmarks in multiple files, use the bookmark window. The bookmark window contains a list of all of your bookmarks.



GAUSS User Guide



3.5.3



CTRL+Q



Used for block commenting.



CTRL+R



Run current file.



CTRL+S



Save current file.



CTRL+T



Switches current line with the line above.



CTRL+V



Paste.



CTRL+W



Closes the current file.



CTRL+Z



Undo.



CTRL+Y



Redo.



CTRL+˜



Cycles through open editor windows.



Find and Replace



From the Edit Menu, selecting Find and Replace or pressing CTRL+F will bring up the find and replace widget at the bottom of your open programming editor. If a word is highlighted when you access find and replace, it will automatically be present in the find box when the find and replace widget is opened. Press the ENTER key or > to search forward. Press the < key to search backwards. To close the find and replace widget, press ESC or click the x button on the left. Exit



Search Search Backward Forward



Search/Replace Replace Backward Highlighted Search/Replace Forward



Figure 3.12: Find and Replace
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Introduction to the GAUSS Graphical User Interface The Replace Box has three buttons: > means replace the highlighted expression and search forwards, < means replace the highlighted expression and search backwards and ∨ means replace the highlighted text and do not change the cursor position.



Regular Expressions



Find and Replace in GAUSS supports regular expression searching. Regular expression searching gives users tremendous power allowing quick and precise search and replace throughout an entire file. For example, let us start with a file containing the following commands: GUI Intro



r = 100; c = 50; x = rndn(r,c); y = rndu(r,c); z = x.*rndn(r,c);



Regular expressions allow you to perform very specific find and replace commands. Suppose that we want to find all usages o f rndu and rndn and replace them with rndKMu. To open Find and Replace, we enter CTRL+F in out open text editor. In the Find and Replace widget, select the check box next to Regex to enable regular expression searching. One of the most simple regular expression options is to add a ‘.’. The ‘.’ means any character. So, if we search for “rnd.” that will find any string that contains rnd followed by any character, such as rnda, rndb, rndc, rndn, rndu, etc. Now enter “rndKMu” in the replace box and click Replace All. Now all instances of rndu and rndn should be replaced with rndKMu.



3.5.4



Changing Editor Properties



Programming editor preferences can be accessed by selecting: Tools->Preferences from the menu bar. From the Preferences window, select Source from the tree on the left. Here you can customize the programming editor’s behavior.
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Figure 3.13: Find and Replace Regular Expression



3.5.5



Command Input Window



The Command Input Window can be accessed by toggling the Input button on the right side of the status bar. For details regarding the features and usage of the Command Input Window, see Section 3.3.2.



3.5.6



Error Output Window



The Error Output Window can be accessed by toggling the Error Output button on the right side of the status bar. For details regarding the features and usage of the Error Output Window, see Section 3.4.2.
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3.6



Data Page



Section 3.2.1 provides details of the main menus and toolbars. The Data Page contains the following changes to the toolbar and menu options.



GUI Intro



Figure 3.14: Data Page



3.6.1



Menu Bar



Symbol Editor Menu



Edit Symbol



Opens an active symbol from your current GAUSS workspace in a symbol editor.



Save Symbol



Saves changes to the symbol in the active symbol editor.



Reload Symbol



Reloads a symbol that is out-of-sync with the GAUSS symbol table. Note: This only applies if auto-reload mode is turned off.



Toggle



Turns on/off autoreload for the active symbol editor.
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Brings up preference dialog for changing the settings of open symbol editors.



Window Menu



Split Horizontally



Tiles open symbol editors horizontally.



Split Vertically



Tiles open symbol editors vertically.



Toolbar Edit Reload Symbol Symbol Save Symbol



Figure 3.15: Data Page Toolbar



New



Opens an active symbol from your current GAUSS workspace in a symbol editor.



Save



Saves changes to the symbol in the active symbol editor.



Reload



Reloads an out-of-sync symbol editor. Note: This applies only if autoreload is disabled.



3.6.2



Layout



The Data Page has two main widgets: the symbol tree and the source editor docking area. The Command Input and Error Windows are also accessible from the toggle buttons on the right side of the status bar.
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Introduction to the GAUSS Graphical User Interface The Symbol Tree window lists all of your active symbols, organized by type. To view your active symbols, click on the node expander or right click and select Symbol View from the context menu. Hovering over a symbol in the Symbol Tree will produce a tooltip with a preview of the symbol’s contents. To view the entire contents of a symbol, double-click the symbol or right-click the symbol and select Edit. The symbol will now appear in a symbol editor (see Section 3.6.3, Symbol Editor). Double-clicking an already open symbol will bring that symbol to the top of the stack of open symbol editors. If you would like to open a second copy of a symbol, right-click on the symbol in the symbol tree and select Edit Another Copy. GAUSS allows you to open more than one copy of each symbol so that you can examine different portions of a large matrix at the same time. GUI Intro



Special Case: Structures



To view a structure in the GAUSS Symbol Editor, click the + next to the Structures node on the Symbol Tree. From here you will see a full list of all structures in your current GAUSS workspace. Clicking the + next to an individual structure will reveal all members of a structure. To view the contents of any member of a GAUSS structure, first open the structure in a Struct Viewer, by either double-clicking or right-clicking and selecting Edit over the name of the structure in the Symbol Tree. Once open in the Struct Viewer, individual members of the structure can be accessed for viewing and editing from the Struct Tree.



The Struct Editor



When opened from the Symbol Tree, structures will be loaded into a special Struct Editor. The Struct Editor is composed of a Struct Tree Widget and a Struct Member Editor. The Struct Tree Widget displays the structure being edited and its members names, data types and dimensions. The Struct Member editor displays the contents of individual struct members. The Struct Editor is displayed in the Source Editor docking area like all other Source Editors. Individual structure members can be opened for editing or viewing from the Struct Tree Widget in the same manner as other data types, such as matrices, are opened from the Symbol Tree. Structure members will be opened in a Symbol Editor to the right of the Struct Tree Widget.
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Figure 3.16: The Struct Editor



3.6.3



Symbol Editor



Symbol editors are like spreadsheets that allow viewing and editing data in your workspace. Data may be viewed in decimal, scientific, hexadecimal, or character representation. Double-clicking in a cell allows you to change its contents. Navigation throughout the cells can be accomplished with the arrow keys, tab, and the mouse. To highlight multiple cells, click on the corresponding row or column header. To highlight the entire contents of a symbol editory, click in the empty header box that connects the first row header to the first column header.



Autoreload



By default, open symbol editors will automatically update when the symbol has been changed programmatically. This behavior is referred to as autoreload. A symbol editor in autoreload mode will show (auto) on its header. The header will also display (sync), indicating that the symbol editor’s contents are synchronized with the current value of the symbol in the GAUSS symbol table. If you would like the contents of a particular symbol editor to stay the same even if the value of the symbol is changed by running a program or an interactive command, you may disable autoreload for that symbol. If the value of a symbol with autoreload disabled is changed in the GAUSS symbol table, the symbol editor will display the message out-of-sync. This indicates that the values in the symbol editor are not current.
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3.7 3.7.1



Debug Page Menus and Toolbars



Go



Runs the program to the next breakpoint.



Stop



Terminates a debugging session.



Toggle



Sets/Clears a breakpoint at the cursor.



Clear



GUI Intro



Breakpoint Clears all breakpoints in a file.



Breakpoints Set Watch



Opens a watch variable in a symbol editor.



Step Into



Runs the next executable line of code in the application and steps into procedures.



Step Over



Runs the next executable line of code, but does not step into procedures.



Step Out



Runs the remainder of the current procedure and stops at the next line in the calling procedure.



Run to Cursor



Runs the program until it reaches the cursor position.



Toggle Set Go Breakpoint Watch Stop



Step Over



Clear Step Breakpoint Into



Run to Cursor



Step Out



Figure 3.17: Debug Toolbar
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The Debug Page is composed of two windows, the Breakpoint List and the Debug Window. The Debug Window is a programming editor window specifically configured for debugging programs. The Debug Window indicates which line it is on by the >>> located in the left margin. This is also the location where breakpoints are added. To add a breakpoint, click in the left margin of the Debug Window on the line you wish to add the breakpoint. Clicking an active breakpoint will remove it.



Figure 3.18: Debug Window



Starting and Stopping the Debugger



You can start debugging of a file you are in by pressing CTRL+D. Click the Debug button to debug the file in the top of the Action List. Placing your mouse over the Debug button will reveal a tooltip with the name of this file, or click the downward pointing triangle next to the debug button and select a file from the list.
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Introduction to the GAUSS Graphical User Interface When the debugger is started, it will highlight the first line of code to be run. Any breakpoints are shown in the left margin of the window. You can stop debugging at any time by clicking the Stop button on the debug toolbar.



3.7.2



Using Breakpoints



Breakpoints stop code execution where you have inserted them. Breakpoints are normally set prior to running the debugger, but can also be set or cleared during debugging by clicking the Set/Clear Breakpoint command on the Debug menu. GUI Intro



3.7.3



Setting and Clearing Breakpoints



To set breakpoints in any part of the file not currently being executed, just click in the left margin of the line on which you would like the breakpoint. Alternatively, you can highlight a line then click Toggle Breakpoint. To clear a breakpoint in the file, click on the breakpoint you would like to remove or click a line of code that has a breakpoint set and then click Set/Clear Breakpoint. You can clear all breakpoints from the active file by clicking Clear All Breakpoints.



3.7.4



Stepping Through a Program



GAUSS’s debugger includes the ability to step into, step out of, and step over code during debugging. Use Step Into to execute the line of code currently highlighted by the debugger. Use Step Out to execute to the end of the current function without pause and return to the calling function. Use Step Over to execute the line of code currently highlighted by the debugger without entering the functions that are called.
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Viewing and Editing Variables



GAUSS allows you to view and edit the values of variables during debugging.



Viewing Variable Values During Debugging



Once the debugger is started, the editor window uses floatover variable windows for viewing variable data. Floatover variable windows give a quick view of the value a variable currently holds by simply moving your mouse over the variable name in the edit window. The floatover variable window is only intended to give a quick view of the data, so it may not show all data held by the variable. If you need to view more data, click on the variable name and type CTRL+E or click the Set Watch Variable and enter the variable name.



Editing Variable Values During Debugging



The debugger integrates the Matrix Editor to edit values of loaded variables, or to use as a watch window to view the changing values of variables as you step through a program. To edit a variable value, highlight the variable in the edit window, or the Command Input Window and then open the Matrix Editor. You can use the menu or toolbar to start the Matrix Editor.



Making a Watch Window



You can make the Matrix Editor a Watch Window, allowing you to watch the changing value of a variable as the lines of the program are executed. You can activate the Watch Window by clicking Set Watch on the Debug toolbar or by highlighting a variable name in the Debugger Window and pressing CTRL+E. You use a Watch Window to see how variables change in value during debugging. Watch variables can be specified prior to running the debugger or during a debugging session. The debugger searches for a watch variable using the following order:
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GUI Intro



Figure 3.19: Watch Window



1. A local variable within a currently active procedure. 2. A global variable.



A watch variable can be the name of a matrix, a scalar, a string array, or a string. For a matrix or a string array, the first element is displayed. If a matrix element is clicked, the Matrix Editor is loaded with the matrix. The matrix elements can be changed during the debugging session.



3.8



Help Page



The Help Page gives you access to the entire GAUSS help system in HTML format. The table of contents tree is on the left. Click the + symbol to expand a particular section of the contents and double-click on the title to view the page. As on the other pages, the Command Input Window and the Error Window are available via toggle buttons on the status bar. It can be helpful to enter an interactive command and/or view error output while simultaneously viewing the relevant documentation.
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Figure 3.20: Help Page



3.8.1
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Hot Keys F1



Opens the Command Reference section for the highlighted command.



CTRL+F1



Opens a programming editor with the function definition of a highlighted procedure.



Navigating the GAUSS Graphical User Interface



4 Navigating the GUI



Navigation of the GAUSS Graphical User Interface is designed to naturally follow your actions. For example, if the action you would like to perform is debugging the file that you are editing, you can either enter CTRL+D to debug or select the file from the Debug Toolbar Button’s drop down Action List. Both of these options will begin your debugging session and take you to the Debug Page. Regardless of the method you choose to initiate the action, debugging in this case, the navigation is done for you. The same automatic and intuitive navigation is enabled for many common GAUSS actions, such as opening a new or existing file for editing or using the F1 help. Since GAUSS program output can be viewed in many ways such as symbol editors on the Data Page or graphic files, running a program or executing a command does not automatically navigate to the Command Page. However, if the Program Output Window from the Command Page is your modality of choice, the option to automatically navigate to the Command Page can be selected as an option under Tools->Preferences.



4-1



GAUSS User Guide



4.1



Hot Keys and Shortcuts F2



Navigates to the next bookmark in the Active File.



F3



Find again.



F5



Run file at top of Action List.



F6



Debug file at top of Action List. Inside a debug session, F6 will cause the debugger to run to the next breakpoint, or the end of the file if no breakpoint is set.



F7



Edit file at top of Action List.



F8



Step in (During a debug session).



F9



Step over (During a debug session).



F10



Step out (During a debug session).



The Control Keys operate on a file that is being edited or is open in a Programming Editor and has focus. This file is referred to as the Active File.



4.2
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CTRL+R



Run the Active File.



CTRL+D



Debug the Active File.



Navigating Between Pages CTRL+1



Brings up the Command Page.



CTRL+2



Brings up the Source Page.



CTRL+3



Brings up the Data Page.



Navigating the GAUSS Graphical User Interface



Brings up the Debug Page.



CTRL+5



Brings up the Help Page.



CTRL+TAB



Brings up the next page. For example, CTRL+TAB from the Command Page will bring up the Source Page. CTRL+TAB from the Help Page will wrap and bring up the Command Page.



ALT+TAB



Cycles between any pages that are undocked as well as other open programs.



WINDOW+TAB



Windows only: Cycles between any pages that are undocked as well as other open programs.



Mouse Scroll Wheel



When floating over any set of tabs, the mouse scroll wheel will cycle through the open tabs. This will work for programming editor tabs, symbol editor tabs, and the main page tabs on the left of the main application.



Navigating the GUI
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CTRL+4



Switch To Command Page on I/O



Under the Tools->Preferences->Command is a check box entitled Switch to Command Page on I/O. Selecting this option will bring you to the command page if any program output is printed to the Program Output Window, or if any input is requested by GAUSS functions key, keyw or cons.



4.4



Viewing Program Output from Other Pages



The Program Output Window may be pulled out of the Command Page by selecting the Program Output banner and dragging it. The Program Output Window may then be placed and resized. The Program Output Window will remain in place and on the top of the window stack, allowing you to navigate freely between any other pages while continuing to observe the program output.
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F1 Help



If your cursor is on the name of a GAUSS command in an editor, you can press F1 and it will take you to the Command Reference listing for that command. Inside the Help system, highlight command names by double-clicking them to enable F1 help navigation.



4.6



CTRL+F1 Source Browsing



For procedures that reside in a GAUSS Library (.lcg file), you can browse to the procedure definition and to the initiation of any global variables with CTRL+F1. Like F1 help, set your cursor on the procedure or global variable name and enter CTRL+F1. If it resides in an active library, the source file will be immediately opened in a Programming Editor. To learn more about creating a User Library for your procedures, see Chapter 15.
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TGAUSS is the command line version of GAUSS. The executable file, tgauss is located in the GAUSS installation directory. The format for using TGAUSS is: tgauss flag(s) program program... Execute file in batch mode and then exit. You can execute multiple files by separating file names with spaces.



-l logfile



Set the name of the batch mode log file when using the -b argument. The default is tmp/gauss.log###, where ### is the process ID.



Command Line



-b



-e expression Execute a GAUSS expression. This command is not logged when GAUSS is in batch mode. -o



Suppress the sign-on banner (output only).



-T



Turn the dataloop translator on.



-t



Turn the dataloop translator off.
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Viewing Graphics



GAUSS generates .tkf files for graphical output. The default output for graphics is graphic.tkf. On Windows, you can use vwr.exe to view the graphics file; on UNIX/Linux/Mac, you can use vwrmp. Two functions are available to convert .tkf files to PostScript for printing and viewing with external viewers: the tkf2ps function will convert .tkf files to PostScript (.ps) files, and the tkf2eps function will convert .tkf files to encapsulated PostScript (.eps) files. For example, to convert the file graphic.tkf to a postscript file named graphic.ps use:



ret = tkf2ps(‘‘filename.tkf ’’, ‘‘filename.ps’’)



If the function is successful it returns 0.



5.2



Command Line History and Command Line Editing



When you run a command at the TGAUSS prompt, it is added to your command line history, which is stored in a file called .gauss_prompt_history in your $(HOME) directory on UNIX/Linux or in your $(HOMEDRIVE)\$(HOMEPATH) directory on Windows. A separate history for commands entered in the command line debugger is stored in a file called .gauss_debug_prompt_history in the same directory. By default, the last 500 commands executed at the TGAUSS and debugger command lines are stored in these files. You can change this number by changing prompt_hist_num in your gauss.cfg file. The following keystrokes are supported for movement and editing at the command line and for retrieving the command line history:



5.2.1
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Movement Left Arrow or CTRL+B



Moves cursor left one character



Right Arrow or CTRL+F



Moves cursor right one character
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Moves cursor to beginning of line



END or CTRL+E



Moves cursor to end of line



ALT+Left Arrow or CTRL+Left Arrow



Moves cursor left one word



ALT+Right Arrow or CTRL+Right Arrow



Moves cursor right one word



Editing DELETE OR CTRL+D



Deletes character at cursor



BACKSPACE or CTRL+H



Deletes character left of cursor



CTRL+U



Cuts all characters left of cursor



CTRL+K



Cuts all characters right of cursor, including cursor



CTRL+X



Cuts whole line



ESC (Win only)



Deletes whole line



CTRL+V



Pastes text from buffer to left of cursor



CTRL+T



Transposes character at cursor and character left of cursor



Command Line



5.2.3



HOME or CTRL+A



History Retrieval Up Arrow or CTRL+P



Retrieves previous line in history



Down Arrow or CTRL+P



Retrieves next line in history
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PAGE UP or CTRL+W



PAGE DOWN CTRL+S



Retrieves previous line in history that matches text to left of cursor or



Retrieves next line in history that matches text to left of cursor



ALT+H or OPTION+H (MAC only)



Prints prompt history to screen



!!



Runs last line in history



!num



Runs the num line in history



!-num



Runs the line num before current line in history; !-1 is equivalent to !!



!text



Runs last line in history beginning with text



ALT+/ or ALT+? or OPTION+/ (MAC only)



Prints help screen



Note that some of these keystrokes are mapped differently on different computers. For example, on some computers, SHIFT+RIGHT ARROW behaves the same as RIGHT ARROW, while ALT+RIGHT ARROW moves the cursor right one word. Therefore, multiple keystroke mappings have been supported to maximize the availability of these commands on any given machine.



5.3 5.3.1



Interactive Commands quit



The quit command will exit TGAUSS. The format for quit is:
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Using the Command Line Interface quit You can also use the system command to exit TGAUSS from either the command line or a program (see system in the GAUSS L R). The format for system is: system



5.3.2



ed



The ed command will open an input file in an external text editor (see ed in the GAUSS L R). The format for ed is: ed filename



5.3.3



browse



The format for browse is: browse symbol



5.3.4



config



The config command gives you access to the configuration menu allowing you to change the way GAUSS runs and compiles files.
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Command Line



The browse command allows you to search for specific symbols in a file and open the file in the default editor. You can use wildcards to extend search capabilities of the browse command.



GAUSS User Guide The format for config is:



config



Run Menu



Translator



Toggles on/off the translation of a file using dataloop. The translator is not necessary for GAUSS program files not using dataloop.



Translator line number tracking



Toggles on/off execution time line number tracking of the original file before translation.



Line number tracking



Toggles on/off the execution time line number tracking. If the translator is on, the line numbers refer to the translated file.



Compile Menu
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Autoload



Toggles on/off the autoloader.



Autodelete



Toggles on/off autodelete.



GAUSS Library



Toggles on/off the GAUSS library functions.



User Library



Toggles on/off the user library functions.



Declare Warnings



Toggles on/off the declare warning messages during compiling.



Compiler Trace



Includes the following options: Off



Turns off the compiler trace function.



File



Traces program file openings and closings.



Line



Traces compilation by line.



Symbol



Creates a report of procedures and the local and global symbols they reference.
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Debugging



The debug command runs a program under the source level debugger. The format for debug is:



debug filename



5.4.1



General Functions



?



Displays a list of available commands.



q/Esc



Exits the debugger and returns to the GAUSS command line.



+/-



Disables the last command repeat function.



5.4.2



Listing Functions Displays a specified number of lines of source code in the current file.



lc



Displays source code in the current file starting with the current line.



ll file line



Displays source code in the named file starting with the specified line.



ll file



Displays source code in the named file starting with the first line.



ll line



Displays source code starting with the specified line. File does not change.



ll



Displays the next page of source code.



lp



Displays the previous page of source code.



5.4.3



Command Line



l number



Execution Functions



s number



Executes the specified number of lines, stepping into procedures.
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Executes the specified number of lines, stepping over procedures.



x number



Executes code from the beginning of the program to the specified line count, or until a breakpoint is hit.



g [[args]]



Executes from the current line to the end of the program, stopping at breakpoints. The optional arguments specify other stopping points. The syntax for each optional argument is: filename line period The debugger will stop every period times it reaches the specified line in the named file. filename line



The debugger will stop when it reaches the specified line in the named file.



filename ,, period



The debugger will stop every period times it reaches any line in the named file.



line period



The debugger will stop every period times it reaches the specified line in the current file.



filename



The debugger will stop at every line in the named file.



line



The debugger will stop when it reaches the specified line in the current file.



procedure period



The debugger will stop every period times it reaches the first line in a called procedure.



procedure



The debugger will stop every time it reaches the first line in a called procedure.



j [[args]]



Executes code to a specified line, procedure, or period in the file without stopping at breakpoints. The optional arguments are the same as g, listed above.



jx number



Executes code to the execution count specified (number) without stopping at breakpoints.



o



Executes the remainder of the current procedure (or to a breakpoint) and stops at the next line in the calling procedure.
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View Commands



v [[vars]]



Searches for (a local variable, then a global variable) and displays the value of a specified variable.



v$ [[vars]]



Searches for (a local variable, then a global variable) and displays the specified character matrix.



The display properties of matrices and string arrays can be set using the following commands.



r



Specifies the number of rows to be shown.



c



Specifies the number of columns to be shown.



num,num



Specifies the indices of the upper left corner of the block to be shown.



w



Specifies the width of the columns to be shown.



p



Specifies the precision shown.



f



Specifies the format of the numbers as decimal, scientific, or auto format.



q



Quits the matrix viewer. Command Line



5.4.5



Breakpoint Commands



lb



Shows all the breakpoints currently defined.



b [[args]]



Sets a breakpoint in the code. The syntax for each optional argument is: filename line period The debugger will stop every period times it reaches the specified line in the named file. filename line



The debugger will stop when it reaches the specified line in the named file.



filename ,, period



The debugger will stop every period times it reaches any line in the named file.
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line period



The debugger will stop every period times it reaches the specified line in the current file.



filename



The debugger will stop at every line in the named file.



line



The debugger will stop when it reaches the specified line in the current file.



procedure period



The debugger will stop every period times it reaches the first line in a called procedure.



procedure



The debugger will stop every time it reaches the first line in a called procedure.



Removes a previously specified breakpoint. The optional arguments are the same arguments as b, listed above.



Using the Source Browser in TGAUSS



To start the Source Browser in TGAUSS, type BROWSE followed by a symbol name. When the Source Browser is active, the prompt displays Browse:. GAUSS searches through all active libraries for the file in which the symbol is defined. If found, the file containing the source code is opened in the default editor. Wildcard (*) searches can also be used. When using wildcard searches, each symbol that the string matches will be displayed on-screen in a numbered list. To select a specific command to view in the default editor, select the number from the list. The Source Browser will remain active until you type CTRL-C to return to the GAUSS prompt.
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GAUSS is a compiled language. GAUSS is also an interpreter. A compiled language, because GAUSS scans the entire program once and translates it into a binary code before it starts to execute the program. An interpreter, because the binary code is not the native code of the CPU. When GAUSS executes the binary pseudocode it must “interpret” each instruction for the computer. How can GAUSS be so fast if it is an interpreter? Two reasons. First, GAUSS has a fast interpreter, and the binary compiled code is compact and efficient. Second, and most significantly, GAUSS is a matrix language. It is designed to tackle problems that can be solved in terms of matrix or vector equations. Much of the time lost in interpreting the pseudocode is made up in the matrix or vector operations. This chapter will enable you to understand the distinction between “compile time” and “execution time”, two very different stages in the life of a GAUSS program.



Expressions



An expression is a matrix, string, constant, function reference, procedure reference, or any combination of these joined by operators. An expression returns a result that can be assigned to a
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GAUSS User Guide variable with the assignment operator ‘=’.



6.2



Statements



A statement is a complete expression or command. Statements end with a semicolon.



y = x*3;



If an expression has no assignment operator (=), it will be assumed to be an implicit print statement:



print x*3;



or



x*3;



Here is an example of a statement that is a command rather than an expression:



output on;



Commands cannot be used as a part of an expression. There can be multiple statements on the same line as long as each statement is terminated with a semicolon.
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Executable Statements



Executable statements are statements that can be “executed” over and over during the execution phase of a GAUSS program (execution time). As an executable statement is compiled, binary code is added to the program being compiled at the current location of the instruction pointer. This binary code will be executed whenever the interpreter passes through this section of the program. If this code is in a loop, it will be executed each iteration of the loop. Here are some examples of executable statements:



y = 34.25;



print y;



x =



6.2.2



1 3 7 2 9 4 0 3 ;



Nonexecutable Statements



Nonexecutable statements are statements that have an effect only when the program is compiled (compile time). They generate no executable code at the current location of the instruction pointer. Here are two examples:



declare matrix x =



1 2 3 4 ;
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external matrix ybar;



Procedure definitions are nonexecutable. They do not generate executable code at the current location of the instruction pointer. Here is an example:
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There are two executable statements in the example above: the first line and the last line. In the binary code that is generated, the last line will follow immediately after the first line. The last line is the call to the procedure. This generates executable code. The procedure definition generates no code at the current location of the instruction pointer. There is code generated in the procedure definition, but it is isolated from the rest of the program. It is executable only within the scope of the procedure and can be reached only by calling the procedure.



6.3



Programs



A program is any set of statements that are run together at one time. There are two sections within a program.



6.3.1



Main Section



The main section of the program is all of the code that is compiled together WITHOUT relying on the autoloader. This means code that is in the main file or is included in the compilation of the main file with an #include statement. ALL executable code should be in the main section. There must always be a main section even if it consists only of a call to the one and only procedure called in the program.
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Secondary Sections



Secondary sections of the program are files that are neither run directly nor included in the main section with #include statements. The secondary sections of the program can be left to the autoloader to locate and compile when they are needed. Secondary sections must have only procedure definitions and other nonexecutable statements. #include statements are allowed in secondary sections as long as the file being included does not violate the above criteria. Here is an example of a secondary section: declare matrix tol = 1.0e-15; proc feq(a,b); retp(abs(a-b) 6000; x = x ˜ data_in(hsec-hsec0); endo; You can test whether a matrix is empty by entering rows(x), cols(x) and scalerr(x). If the matrix is empty rows and cols will return a 0, and scalerr will return 65535. The ∼ is the horizontal concatenation operator and the | is the vertical concatenation operator. The statement y = 1∼2|3∼4; will be evaluated as y = (1 ∼ 2) | (3 ∼ 4);



1 2 3 4
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and will result in a 2×2 matrix because horizontal concatenation has precedence over vertical concatenation:



GAUSS User Guide The statement



y = 1+1∼2*2|3-2∼6/2;



will be evaluated as y = ((1 + 1) ∼ (2 ∗ 2)) | ((3 − 2) ∼ (6/2));



and will result in a 2×2 matrix because the arithmetic operators have precedence over concatenation: 2 4 1 3



For more information, see O P, Section 7.7. The let command is used to initialize matrices with constant values:



let x[2,2] = 1 2 3 4;



Unlike the concatenation operators, it cannot be used to define matrices in terms of expressions such as



y = x1-x2∼x2|x3*3∼x4;



The statement



y = x[1:3,5:8];
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Language Fundamentals will put the intersection of the first three rows and the fifth through eighth columns of x into the matrix y. The statement



y = x[1 3 1,5 5 9];



will create a 3×3 matrix y with the intersection of the specified rows and columns pulled from x (in the indicated order). The following code



let r = 1 3 1; let c = 5 5 9; y = x[r,c];



will have the same effect as the previous example, but is more general. The statement



y[2,4] = 3;



will set the 2,4 element of the existing matrix y to 3. This statement is illegal if y does not have at least 2 rows and 4 columns. The statement
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x = con(3,2);



will cause the following prompt to be printed in the window:



- (1,1)
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GAUSS User Guide indicating that the user should enter the [1,1] element of the matrix. Entering a number and then pressing ENTER will cause a prompt for the next element of the matrix to appear. Pressing ? will display a help screen, and pressing x will exit. The statement load x[] = b:mydata.asc will load data contained in an ASCII file into an N×1 vector x. (Use rows(x) to find out how many numbers were loaded, and use reshape(x,N,K) to reshape it to an N×K matrix). The statement load x; will load the matrix x.fmt from disk (using the current load path) into the matrix x in memory. The statement open d1 = dat1; x = readr(d1,100); will read the first 100 rows of the GAUSS data set dat1.dat.



6.6.3



Sparse Matrices



Many GAUSS operators and commands support the sparse matrix data type. You may use any of the following commands to create a sparse matrix:
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denseToSp



Converts a dense matrix to a sparse matrix.



denseToSpRE



Converts a dense matrix to a sparse matrix, using a relative epsilon.
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Creates a sparse matrix from a packed matrix of non-zero values and row and column indices.



spCreate



Creates a sparse matrix from vectors of non-zero values, row indices, and column indices.



spEye



Creates a sparse identity matrix.



spOnes



Generates a sparse matrix containing only ones and zeros



spZeros



Creates a sparse matrix containing no non-zero values.



See S M, Chapter 9, for more information.



6.6.4



N-dimensional Arrays



Many GAUSS commands support arrays of N dimensions. The following commands may be used to create and manipulate an N-dimensional array:



Concatenate conformable matrices and arrays in a user-specified dimension.



aeye



Create an N-dimensional array in which the planes described by the two trailing dimensions of the array are equal to the identity.



areshape



Reshape a scalar, matrix, or array into an array of user-specified size.



arrayalloc



Create an N-dimensional array with unspecified contents.



arrayinit



Create an N-dimensional array with a specified fill value.



mattoarray



Convert a matrix to a type array.
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aconcat



See N-D A, Chapter 10, for a more detailed explanation.
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Strings



Strings can be used to store the names of files to be opened, messages to be printed, entire files, or whatever else you might need. Any byte value is legal in a string from 0–255. The buffer where a string is stored always contains a terminating byte of ASCII 0. This allows passing strings as arguments to C functions through the Foreign Language Interface. Here is a partial list of the functions for manipulating strings:
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Combine two strings into one long string.



ˆ



Interpret following name as a variable, not a literal.



chrs



Convert vector of ASCII codes to character string.



dttostr



Convert a matrix containing dates in DT scalar format to a string array.



ftocv



Character representation of numbers in N×K matrix.



ftos



Character representation of numbers in 1×1 matrix.



ftostrC



Convert a matrix to a string array using a C language format specification.



getf



Load ASCII or binary file into string.



indcv



Find index of element in character vector.



lower



Convert to lowercase.



stof



Convert string to floating point.



strindx



Find index of a string within a second string.



strlen



Length of a string.



strsect



Extract substring of string.



strsplit



Split an N×1 string vector into an N×K string array of the individual tokens.



Language Fundamentals strsplitPad



Split a string vector into a string array of the individual tokens. Pads on the right with null strings.



strtodt



Convert a string array of dates to a matrix in DT scalar format.



strtof



Convert a string array to a numeric matrix.



strtofcplx



Convert a string array to a complex numeric matrix.



upper



Convert to uppercase.



vals



Convert from string to numeric vector of ASCII codes.



Strings can be created like this:



x = "example string";



or x = cons;



/* keyboard input */



x = getf("myfile",0);



/* read a file into a string */



or



They can be printed like this: Language Fundamentals



print x; A character matrix must have a ‘$’ prefixed to it in a print statement:



print $x;
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backspace (ASCII 8) escape (ASCII 27) formfeed (ASCII 12) beep (ASCII 7) line feed (ASCII 10) carriage return (ASCII 13) tab (ASCII 9) a backslash the ASCII character whose decimal value is “###”.



When entering DOS pathnames in double quotes, two backslashes must be used to insert one backslash: st = "c:\\gauss\\myprog.prg"; An important use of strings and character elements of matrices is with the substitution operator (ˆ). In the command create f1 = olsdat with x,4,2;
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Language Fundamentals by default, GAUSS will interpret the olsdat as a literal; that is, the literal name of the GAUSS data file you want to create. It will also interpret the x as the literal prefix string for the variable names: x1 x2 x3 x4. If you want to get the data set name from a string variable, the substitution operator (ˆ) could be used as:



dataset="olsdat"; create f1=ˆdataset with x,4,2;



If you want to get the data set name from a string variable and the variable names from a character vector, use



dataset="olsdat"; let vnames=age pay sex; create f1=ˆdataset with ˆvnames,0,2;



The substitution operator (ˆ) works with load and save also:



lpath="/gauss/procs"; name="mydata"; load path=ˆlpath x=ˆname; command="dir *.fmt";



The general syntax is: Language Fundamentals



ˆvariable name



Expressions are not allowed. The following commands are supported with the substitution operator (ˆ):
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GAUSS User Guide create f1=ˆdataset with ˆvnames,0,2; create f1=ˆdataset using ˆcmdfile; open f1=ˆdataset; output file=ˆoutfile; load x=ˆdatafile; load path=ˆlpath x,y,z,t,w; loadexe buf=ˆexefile; save ˆname=x; save path=ˆspath; dos ˆcmdstr; run ˆprog; msym ˆmstring;



6.6.6



String Arrays



String arrays are N×K matrices of strings. Here is a partial list of the functions for manipulating string arrays:



$|



Vertical string array concatenation operator.



$∼



Horizontal string array concatenation operator.



[ ]



Extract subarrays or individual strings from their corresponding array, or assign their values.
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0



Transpose operator.



.0



Bookkeeping transpose operator.



declare



Initialize variables at compile time.



delete



Delete specified global symbols.



fgetsa



Read multiple lines of text from a file.



fgetsat



Reads multiple lines of text from a file, discarding newlines.



Language Fundamentals format



Define output format for matrices, string arrays, and strings.



fputs



Write strings to a file.



fputst



Write strings to a file, appending newlines.



let



Initialize matrices, strings, and string arrays.



loads



Load a string or string array file (.fst file).



lprint



Print expressions to the printer.



lshow



Print global symbol table to the printer.



print



Print expressions on window and/or auxiliary output.



reshape



Reshape a matrix or string array to new dimensions.



save



Save matrix, string array, string, procedure, function or keyword to disk and gives the disk file either a .fmt, .fst or .fcg extension.



show



Display global symbol table.



sortcc



Quick-sort rows of matrix or string array based on character column.



type



Indicate whether variable passed as argument is matrix, string, or string array.



typecv



Indicate whether variables named in argument are strings, string arrays, matrices, procedures, functions or keywords. Access the global variable named by a string array.



varput



Assign the global variable named by a string array.



vec



Stack columns of a matrix or string array to form a column vector.



vecr



Stack rows of a matrix or string array to form a column vector.



String arrays are created through the use of the string array concatenation operators. Below is a contrast of the horizontal string and horizontal string array concatenation operators.
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GAUSS User Guide x = "age"; y = "pay"; n = "sex"; s = x $+ y $+ n; sa = x $∼ y $∼ n; s = agepaysex sa = age
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pay



sex



Character Matrices



Matrices can have either numeric or character elements. For convenience, a matrix containing character elements is referred to as a character matrix. A character matrix is not a separate data type, but gives you the ability to store and manipulate data elements that are composed of ASCII characters as well as floating point numbers. For example, you may want to concatenate a column vector containing the names of the variables in an analysis onto a matrix containing the coefficients, standard errors, t-statistic, and p-value. You can then print out the entire matrix with a separate format for each column with one call to the function printfm. The logic of the programs will dictate the type of data assigned to a matrix, and the increased flexibility allowed by being able to bundle both types of data together in a single matrix can be very powerful. You could, for instance, create a moment matrix from your data, concatenate a new row onto it containing the names of the variables and save it to disk with the save command. Numeric matrices are double precision, which means that each element is stored in 8 bytes. A character matrix can thus have elements of up to 8 characters. GAUSS does not automatically keep track of whether a matrix contains character or numeric information. The ASCII to GAUSS conversion program ATOG will record the types of variables in a data set when it creates it. The create command will, also. The function vartypef gets a vector of variable type information from a data set. This vector of ones and zeros can be used by printfm when printing your data. Since GAUSS does not know whether a matrix has character or
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Language Fundamentals numeric information, it is up to you to specify which type of data it contains when printing the contents of the matrix. (For details, see print and printfm in the GAUSS L R.) Most functions that take a string argument will take an element of a character matrix also, interpreting it as a string of up to 8 characters.



6.6.8



Date and Time Formats



DT Scalar Format



The DT scalar format is a double precision representation of the date and time. In the DT scalar format, the number 20010421183207 represents 18:32:07 or 6:32:07 PM on April 21, 2001.



DTV Vector Format



The DTV vector is a 1×8 vector. The format for the DTV vector is: Year Month, 1-12 Day of month, 1-31 Hour of day, 0-23 Minute of hour, 0-59 Second of minute, 0-59 Day of week, 0-6 where 0 is Sunday Day since beginning of year, 0-365



Language Fundamentals



[1] [2] [3] [4] [5] [6] [7] [8]



UTC Scalar Format



The UTC scalar format is the number of seconds since January 1, 1970, Greenwich Mean Time.



6-27



GAUSS User Guide 6.6.9



Special Data Types



The IEEE floating point format has many encodings that have special meaning. The print command will print them accurately so that you can tell if your calculation is producing meaningful results.



NaN



There are many floating point encodings which do not correspond to a real number. These encodings are referred to as NaN’s. NaN stands for Not A Number. Certain numerical errors will cause the math coprocessor to create a NaN called an “indefinite”. This will be printed as a -NaN when using the print command. These values are created by the following operations: • +∞ plus −∞ • +∞ minus +∞ • −∞ minus −∞ • 0∗∞ • ∞/∞ • 0/0 • Operations where one or both operands is a NaN • Trigonometric functions involving ∞



INF



When the math coprocessor overflows, the result will be a properly signed infinity. Subsequent calculations will not deal well with an infinity; it usually signals an error in your program. The result of an operation involving an infinity is most often a NaN.
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When some math coprocessors underflow, they may do so gradually by shifting the significand of the number as necessary to keep the exponent in range. The result of this is a denormal (DEN). When denormals are used in calculations, they are usually handled automatically in an appropriate way. The result will either be an unnormal (UNN), which like the denormal represents a number very close to zero, or a normal, depending on how significant the effect of the denormal was in the calculation. In some cases the result will be a NaN. Following are some procedures for dealing with these values. These procedures are not defined in the Run-Time Library. If you want to use them, you will need to define them yourself. The procedure isindef will return 1 (true) if the matrix passed to it contains any NaN’s that are the indefinite mentioned earlier. The GAUSS missing value code as well as GAUSS scalar error codes are NaN’s, but this procedure tests only for indefinite: proc isindef(x); retp(not x $/= __INDEFn); endp; Be sure to call gausset before calling isindef. gausset will initialize the value of the global __INDEFn to a platform-specific encoding. The procedure normal will return a matrix with all denormals and unnormals set to zero. proc normal(x); retp(x .* (abs(x) .> 4.19e-307)); endp; Language Fundamentals



The procedure isinf, will return 1 (true) if the matrix passed to it contains any infinities: proc isinf(x); local plus,minus; plus = __INFp;
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GAUSS User Guide minus = __INFn; retp(not x /= plus or not x /= minus); endp;



Be sure to call gausset before calling isinf. gausset will initialize the values of the globals __INFn and __INFp to platform specific encodings.



6.7



Operator Precedence



The order in which an expression is evaluated is determined by the precedence of the operators involved and the order in which they are used. For example, the * and / operators have a higher precedence than the + and - operators. In expressions that contain these operators, the operand pairs associated with the * or / operator are evaluated first. Whether * or / is evaluated first depends on which comes first in the particular expression. For a listing of the precedence of all operators, see O P, Section 7.7. The expression



-5+3/4+6*3



is evaluated as



(−5) + (3/4) + (6 ∗ 3)



Within a term, operators of equal precedence are evaluated from left to right. The term



2ˆ3ˆ7
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Language Fundamentals is evaluated (23 )7 In the expression f1(x)*f2(y) f1 is evaluated before f2. Here are some examples:



Evaluation



a+b*c+d



(a + (b ∗ c)) + d



-2+4-6*inv(8)/9



((−2) + 4) − ((6 ∗ inv(8))/9)



3.14ˆ5*6/(2+sqrt(3)/4)



((3.145 ) ∗ 6)/(2 + (sqrt(3)/4))



-a+b*cˆ2



(−a) + (b ∗ (c2 ))



a+b-c+d-e



(((a + b) − c) + d) − e



aˆbˆc*d



((ab )c ) ∗ d



a*b/d*c



((a ∗ b)/d) ∗ c



aˆb+c*d



(ab ) + (c ∗ d)



2ˆ4!



2(4!)



2*3!



2 ∗ (3!) Language Fundamentals



6.8



Expression



Flow Control



A computer language needs facilities for decision making and looping to control the order in which computations are done. GAUSS has several kinds of flow control statements.
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Looping



do loop



The do statement can be used in GAUSS to control looping. do while scalar expression; /* loop if expression is true */ . . statements . . endo; also do until scalar expression; /* loop if expression is false */ . . statements . . endo; The scalar expression is any expression that returns a scalar result. The expression will be evaluated as TRUE if its real part is nonzero and FALSE if it is zero. There is no counter variable that is automatically incremented in a do loop. If one is used, it must be set to its initial value before the loop is entered and explicitly incremented or decremented inside the loop. The following example illustrates nested do loops that use counter variables. format /rdn 1,0; space = " "; comma = ","; i = 1; do while i y; z = x gt y; z = x $> y; If the relational operator IS preceded by a dot ‘.’, then the result will be a matrix of 1’s and 0’s, based upon an element-by-element comparison of x and y. • Element-by-element less than z = x .< y; z = x .lt y; z = x .$< y;
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GAUSS User Guide • Element-by-element less than or equal to z = x .= y; • Element-by-element greater than z = x .> y; z = x .gt y; z = x .$> y;
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7.4



Logical Operators



The logical operators perform logical or Boolean operations on numeric values. On input a nonzero value is considered TRUE and a zero value is considered FALSE. The logical operators return a 1 if TRUE and a 0 if FALSE. Decisions are based on the following truth tables:



Complement



not X F T



X T F



Conjunction



X T T F F



Y T F T F



X and Y T F F F



Disjunction



X T T F F



Y T F T F



X or Y T T T F
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X T T F F



Y T F T F



X xor Y F T T F



Equivalence



X T T F F



Y T F T F



X eqv Y T F F T



For complex matrices, the logical operators consider only the real part of the matrices. The following operators require scalar arguments. These are the ones to use in if and do statements: • Complement z = not x; • Conjunction z = x and y; • Disjunction z = x or y; • Exclusive or z = x xor y;
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• Equivalence z = x eqv y; If the logical operator is preceded by a dot ‘.’, the result will be a matrix of 1’s and 0’s based upon an element-by-element logical comparison of x and y: • Element-by-element logical complement z = .not x; • Element-by-element conjunction z = x .and y; • Element-by-element disjunction z = x .or y; • Element-by-element exclusive or z = x .xor y; • Element-by-element equivalence z = x .eqv y;



7.5



Other Operators



Assignment Operator



Assignments are done with one equal sign: y = 3;
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Commas are used to delimit lists: clear x,y,z; to separate row indices from column indices within brackets: y = x[3,5]; and to separate arguments of functions within parentheses: y = momentd(x,d);



Period



Dots are used in brackets to signify “all rows” or “all columns”: y = x[.,5];



Space



Spaces are used inside of index brackets to separate indices: y = x[1 3 5,3 5 9]; No extraneous spaces are allowed immediately before or after the comma, or immediately after the left bracket or before the right bracket. Spaces are also used in print and lprint statements to separate the separate expressions to be printed:
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print x/2 2*sqrt(x); No extraneous spaces are allowed within expressions in print or lprint statements unless the expression is enclosed in parentheses: print (x / 2) (2 * sqrt(x));



Colon



A colon is used within brackets to create a continuous range of indices: y = x[1:5,.];



Ampersand



The (&) ampersand operator will return a pointer to a procedure (proc), function (fn), or structure (struct). It is used when passing procedures or functions to other functions, when indexing procedures, and when initializing structure pointers. (For more information, see I P, Section 8.5 or S P, Section 12.2.)



String Concatenation



x = "dog"; y = "cat"; z = x $+ y; print z; dogcat If the first argument is of type string, the result will be of type string. If the first argument is of type matrix, the result will be of type matrix. Here are some examples:
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GAUSS User Guide y = 0 $+ "caterpillar";



The result will be a 1×1 matrix containing ‘caterpil’.



y = zeros(3,1) $+ "cat";



The result will be a 3×1 matrix, each element containing ‘cat’. If we use the y created above in the following:



k = y $+ "fish";



The result will be a 3×1 matrix with each element containing ‘catfish’. If we then use k created above:



t = "" $+ k[1,1];



The result will be a string containing ‘catfish’. If we used the same k to create z as follows:



z = "dog" $+ k[1,1];



The resulting z will be a string containing ‘dogcatfish’.



String Array Concatenation



$| Vertical string array concatenation



7-18



x = "dog"; y = "fish"; k = x $| y; print k; dog fish $∼ Horizontal string array concatenation x = "dog"; y = "fish"; k = x $˜ y; print k; dog



fish



String Variable Substitution



In a command like the following: create f1 = olsdat with x,4,2; by default GAUSS will interpret olsdat as the literal name of the GAUSS data file you want to create. It will also interpret x as the literal prefix string for the variable names x1 x2 x3 x4. To get the data set name from a string variable, the substitution operator (ˆ) could be used as follows: dataset = "olsdat"; create f1 = ˆdataset with x,4,2; To get the data set name from a string variable and the variable names from a character vector, use the following:
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GAUSS User Guide dataset = "olsdat"; vnames = { age, pay, sex }; create f1 = ˆdataset with ˆvnames,0,2;



The general syntax is:



ˆvariable name



Expressions are not allowed. The following commands are currently supported with the substitution operator (ˆ) in the current version.



create f1 = ˆdataset with ˆvnames,0,2; create f1 = ˆdataset using ˆcmdfile; open f1 = ˆdataset; output file = ˆoutfile; load x = ˆdatafile; load path = ˆlpath x,y,z,t,w; loadexe buf = ˆexefile; save ˆname = x; save path = ˆspath; dos ˆcmdstr; run ˆprog; msym ˆmstring;
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Using Dot Operators with Constants



When you use those operators preceded by a ‘.’ (dot operators) with a scalar integer constant, insert a space between the constant and any following dot operator. Otherwise, the dot will be interpreted as part of the scalar; that is, the decimal point. For example:
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let y = 1 2 3; x = 2.= .eq .ge .gt .le .lt .ne .not .and .or .xor .eqv $/= $< $



Precedence 65 65 65 65 65 65 65 65 65 65 65 65 65 64 63 62 61 60 55 55 55 55 55



Operator $>= /= < >= eq ge gt le lt ne not and or xor eqv (space) : =



Precedence 55 55 55 55 55 55 55 55 55 55 55 55 55 49 48 47 46 45 35 35 10
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Procedures are multiple-line, recursive functions that can have either local or global variables. Procedures allow a large computing task to be written as a collection of smaller tasks. These smaller tasks are easier to work with and keep the details of their operation from the other parts of the program that do not need to know them. This makes programs easier to understand and easier to maintain. A procedure in GAUSS is basically a user-defined function that can be used as if it were an intrinsic part of the language. A procedure can be as small and simple or as large and complicated as necessary to perform a particular task. Procedures allow you to build on your previous work and on the work of others rather than starting over again and again to perform related tasks. Any intrinsic command or function may be used in a procedure, as well as any user-defined function or other procedure. Procedures can refer to any global variable; that is, any variable in the global symbol table that can be shown with the show command. It is also possible to declare local variables within a procedure. These variables are known only inside the procedure they are defined in and cannot be accessed from other procedures or from the main level program code. All labels and subroutines inside a procedure are local to that procedure and will not be confused with labels of the same name in other procedures.
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8.1



Defining a Procedure



A procedure definition consists of five parts, four of which are denoted by explicit GAUSS commands: 1. 2. 3. 4. 5.



Procedure declaration Local variable declaration Body of procedure Return from procedure End of procedure definition



proc statement local statement retp statement endp statement



There is always one proc statement and one endp statement in a procedure definition. Any statements that come between these two statements are part of the procedure. Procedure definitions cannot be nested. local and retp statements are optional. There can be multiple local and retp statements in a procedure definition. Here is an example:



proc (3) = regress(x, y); local xxi,b,ymxb,sse,sd,t; xxi = invpd(x’x); b = xxi * (x’y); ymxb = y-xb; sse = ymxb’ymxb/(rows(x)-cols(x)); sd = sqrt(diag(sse*xxi)); t = b./sd; retp(b,sd,t); endp;



This could be used as a function that takes two matrix arguments and returns three matrices as a result. For example: is:



{ b,sd,t } = regress(x,y);



Following is a discussion of the five parts of a procedure definition.
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Procedures and Keywords 8.1.1



Procedure Declaration



The proc statement is the procedure declaration statement. The format is:



rets



Optional constant, number of values returned by the procedure. Acceptable values here are 0-1023; the default is 1.



name



Name of the procedure, up to 32 alphanumeric characters or an underscore, beginning with an alpha or an underscore.



arg#



Names that will be used inside the procedure for the arguments that are passed to the procedure when it is called. There can be 0-1023 arguments. These names will be known only in the procedure being defined. Other procedures can use the same names, but they will be separate entities.



8.1.2



Local Variable Declarations



The local statement is used to declare local variables. Local variables are variables known only to the procedure being defined. The names used in the argument list of the proc statement are always local. The format of the local statement is:



local x,y,f :proc,g:fn,z,h:keyword;



Local variables can be matrices or strings. If :proc, :fn, or :keyword follows the variable name in the local statement, the compiler will treat the symbol as if it were a procedure, function, or keyword respectively. This allows passing procedures, functions, and keywords to other procedures. (For more information, see P P  P, Section 8.4. Variables that are global to the system (that is, variables listed in the global symbol table that can be shown with the show command) can be accessed by any procedure without any redundant declaration inside the procedure. If you want to create variables known only to the procedure
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proc [[(rets) =]] name([[arg1,arg2,...argN]]);



GAUSS User Guide being defined, the names of these local variables must be listed in a local statement. Once a variable name is encountered in a local statement, further references to that name inside the procedure will be to the local rather than to a global having the same name. (See clearg, varget, and varput in the GAUSS L R for ways of accessing globals from within procedures that have locals with the same name.) The local statement does not initialize (set to a value) the local variables. If they are not passed in as parameters, they must be assigned some value before they are accessed or the program will terminate with a Variable not initialized error message. All local and global variables are dynamically allocated and sized automatically during execution. Local variables, including those that were passed as parameters, can change in size during the execution of the procedure. Local variables exist only when the procedure is executing and then disappear. Local variables cannot be listed with the show command. The maximum number of locals is limited by stack space and the size of workspace memory. The limiting factor applies to the total number of active local symbols at any one time during execution. If cat has 10 locals and it calls dog which has 20 locals, there are 30 active locals whenever cat is called. There can be multiple local statements in a procedure. They will affect only the code in the procedure that follows. Therefore, for example, it is possible to refer to a global x in a procedure and follow that with a local statement that declares a local x. All subsequent references to x would be to the local x. (This is not good programming practice, but it demonstrates the principle that the local statement affects only the code that is physically below it in the procedure definition.) Another example is a symbol that is declared as a local and then declared as a local procedure or function later in the same procedure definition. This allows doing arithmetic on local function pointers before calling them. (For more information, see I P, Section 8.5.



8.1.3



Body of Procedure



The body of the procedure can have any GAUSS statements necessary to perform the task the procedure is being written for. Other user-defined functions and other procedures can be referenced as well as any global matrices and strings.
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Procedures and Keywords GAUSS procedures are recursive, so the procedure can call itself as long as there is logic in the procedure to prevent an infinite recursion. The process would otherwise terminate with either an Insufficient workspace memory message or a Procedure calls too deep message, depending on the space necessary to store the locals for each separate invocation of the procedure. Procedures



8.1.4



Returning from the Procedure



The return from the procedure is accomplished with the retp statement: retp; retp(expression1,expression2,. . .,expressionN); The retp statement can have multiple arguments. The number of items returned must coincide with the number of rets in the proc statement. If the procedure was defined with no items returned, the retp statement is optional. The endp statement that ends the procedure will generate an implicit retp with no objects returned. If the procedure returns one or more objects, there must be an explicit retp statement. There can be multiple retp statements in a procedure, and they can be anywhere inside the body of the procedure.



8.1.5



End of Procedure Definition



The endp statement marks the end of the procedure definition: endp; An implicit retp statement that returns nothing is always generated here so it is impossible to run off the end of a procedure without returning. If the procedure was defined to return one or more objects, executing this implicit return will result in a Wrong number of returns error message and the program will terminate.
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8.2



Calling a Procedure



Procedures are called like this:



dog(i,j,k);



/* no returns */



y = cat(i,j,k);



/* one return */



{ x,y,z } = bat(i,j,k);



/* multiple returns */



call bat(i,j,k);



/* ignore any returns */



Procedures are called in the same way that intrinsic functions are called. The procedure name is followed by a list of arguments in parentheses. The arguments must be separated by commas. If there is to be no return value, use



proc (0) = dog(x,y,z);



when defining the procedure and use



dog(ak,4,3);



or



call dog(ak,4,3);



when calling it. The arguments passed to procedures can be complicated expressions involving calls to other functions and procedures. This calling mechanism is completely general. For example,
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Procedures and Keywords y = dog(cat(3*x,bird(x,y))-2,2,1);



is legal. Procedures



8.3



Keywords



A keyword, like a procedure, is a subroutine that can be called interactively or from within a GAUSS program. A keyword differs from a procedure in that a keyword accepts exactly one string argument, and returns nothing. Keywords can perform many tasks not as easily accomplished with procedures.



8.3.1



Defining a Keyword



A keyword definition is much like a procedure definition. Keywords always are defined with 0 returns and 1 argument. The beginning of a keyword definition is the keyword statement:



keyword name(strarg);



name



Name of the keyword, up to 32 alphanumeric characters or an underscore, beginning with an alpha or an underscore.



strarg



Name that will be used inside of the keyword for the argument that is passed to the keyword when it is called. There is always one argument. The name is known only in the keyword being defined. Other keywords can use the same name, but they will be separate entities. This will always be a string. If the keyword is called with no characters following the name of the keyword, this will be a null string.



The rest of the keyword definition is the same as a procedure definition. (For more information, see D  P, Section 8.1. Keywords always return nothing. Any retp statements, if used, should be empty. For example:
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GAUSS User Guide keyword add(s); local tok, sum; if s $=\,= ""; print "The argument is a null string"; retp; endif; print "The argument is: ’" s "’"; sum = 0; do until s $=\,= ""; { tok, s } = token(s); sum = sum + stof(tok); endo; format /rd 1,2; print "The sum is: " sum; endp;



The keyword defined above will print the string argument passed to it. The argument will be printed enclosed in single quotes.



8.3.2



Calling a Keyword



When a keyword is called, every character up to the end of the statement, excluding the leading spaces, is passed to the keyword as one string argument. For example, if you type



add 1 2 3 4 5;



the keyword will respond



The sum is:
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15.00



Procedures and Keywords Here is another example:



add; Procedures



the keyword will respond



The argument is a null string



8.4



Passing Procedures to Procedures



Procedures and functions can be passed to procedures in the following way:



proc max(x,y); /* procedure to return maximum */ if x>y; retp(x); else; retp(y); endif; endp; proc min(x,y); /* procedure to return minimum */ if x .> >= .>= < .< x = rndn(10,5);
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Structures



To reference a member of a structure using a pointer to that structure, we use an “arrow” syntax. For example, we might use the following code to set the x member of es using the pointer esp:



GAUSS User Guide This code will modify es, since esp is merely a pointer to es. Structure pointers cannot be members of a structure. The following is illegal:



struct example_struct_2 { matrix z; struct example_struct *ep; };



Therefore, since a structure pointer will never be a member of a structure, neither



sp1->sp2->x;



nor s.sp1->x; will ever be valid (sp1 and sp2 are assumed to be structure pointers, s a structure instance, and x a matrix). The “arrow” (->) will only be valid if it is used for the first (or furthest left) dereference, as in:



sp1->st.x;



At this point we do not support indexing of structure pointers. Thus, a structure pointer should point at a scalar structure instance, not a matrix of structures. However, you may index members of that scalar structure instance. So, for example, let us suppose that you defined the following structure types:



struct sb { matrix y; matrix z;
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Structures }; struct sa { matrix x; struct structb s; }; and then created an instance of an sa structure, a0, setting a0.s to a 3×2 matrix of sb structures. The following would be legal: struct sa *sap sap = &a0; sap->s[3,1].y = rndn(3,3);



12.2.3



Using Structure Pointers in Procedures



Structure pointers are especially useful in cases where structures are passed into and out of procedures. If a procedure takes a structure as an argument and modifies any members of that structure, then it makes a local copy of the entire structure before modifying it. Thus if you want to have the modified copy of the structure after running the procedure, you need to pass the structure out of the procedure as one of its return arguments. For example: struct example_struct { matrix x; matrix y; matrix z; }; Structures



proc product(struct example_struct es); es.z = (es.x).*(es.y); retp(es); endp; struct example_struct es1;
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es1.x = rndn(1000,100); es1.y = rndn(1000,1); es1 = product(es1);



In this example, the structure es1 is passed into the procedure, copied and modified. The modified structure is then passed out of the procedure and assigned back to es1. Structure pointers allow you to avoid such excessive data copying and eliminate the need to pass a structure back out of a procedure in cases like this. When you pass a structure pointer into a procedure and then modify a member of the structure that it references, the actual structure is modified rather than a local copy of it. Thus there is no need to pass the modifed structure back out of the procedure. For example, the above example could be accomplished using structure pointers as follows:



struct example_struct { matrix x; matrix y; matrix z; }; proc(0) = product(struct example_struct *esp); esp->z = (esp->x).*(esp->y); endp; struct example_struct es1; struct example_struct *es1p; es1p = &es1; es1.x = rndn(1000,100); es1.y = rndn(1000,1); product(es1p);



In this case, the procedure modifies the structure es1, which es1p is pointing at, instead of a local copy of the structure.
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Special Structures



There are three common types of structures that will be found in the GAUSS Run-Time Library and applications. The DS and PV structures are defined in the GAUSS Run-Time Library. Their definitions are found in ds.sdf and pv.sdf, respectively, in the src source code subdirectory. Before structures, many procedures in the Run-Time Library and all applications had global variables serving a variety of purposes, such as setting and altering defaults. Currently, these variables are being entered as members of “control” structures.



12.3.1



The DS Structure



The DS structure, or “data” structure, is a very simple structure. It contains a member for each GAUSS data type. The following is found in ds.sdf: struct DS { scalar type; matrix dataMatrix; array dataArray; string dname; string array vnames; }; This structure was designed for use by the various optimization functions in GAUSS, in particular, sqpSolvemt, as well as a set of gradient procedures, gradmt, hessmt, et al.



To initialize an instance of a DS structure, the procedure dsCreate is defined in ds.src:
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These procedures all require that the user provide a procedure computing a function (to be optimized or take the derivative of, etc.), which takes the DS structure as an argument. The Run-Time Library procedures such as sqpSolvemt take the DS structure as an argument and pass it on to the user-provided procedure without modification. Thus, the user can put into that structure whatever might be needed as data in the procedure.



GAUSS User Guide #include ds.sdf struct DS d0; d0 = dsCreate;



12.3.2



The PV Structure



The PV structure, or parameter vector structure, is used by various optimization, modelling, and gradient procedures, in particular sqpSolvemt, for handling the parameter vector. The GAUSS Run-Time Library contains special functions that work with this structure. They are prefixed by “pv” and defined in pv.src. These functions store matrices and arrays with parameters in the structure, and retrieve various kinds of information about the parameters and parameter vector from it.



“Packing” into a PV Structure



The various procedures in the Run-Time Library and applications for optimization, modelling, derivatives, etc., all require a parameter vector. Parameters in complex models, however, often come in matrices of various types, and it has been the responsibility of the programmer to generate the parameter vector from the matrices and vice versa. The PV procedures make this problem much more convenient to solve. The typical situation involves two parts: first, “packing” the parameters into the PV structure, which is then passed to the Run-Time Library procedure or application; and second, “unpacking” the PV structure in the user-provided procedure for use in computing the objective function. For example, to pack parameters into a PV structure: #include sqpsolvemt.sdf /* starting values */ b0 = 1; /* constant in mean equation */ garch = { .1, .1 }; /* garch parameters */ arch = { .1, .1 }; /* arch parameters */ omega = .1; /* constant in variance equation */
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Structures struct PV p0; p0 p0 p0 p0



= = = =



pvPack(pvCreate,b0,"b0"); pvPack(p0,garch,"garch"); pvPack(p0,arch,"arch"); pvPack(p0,omega,"omega");



/* data */ z = loadd("tseries"); struct DS d0; d0.dataMatrix = z;



Next, in the user-provided procedure for computing the objective function, in this case minus the log-likelihood, the parameter vector is unpacked: proc ll(struct PV p0, struct DS d0); local b0,garch,arch,omega,p,q,h,u,vc,w; b0 = pvUnpack(p0,"b0"); garch = pvUnpack(p0,"garch"); arch = pvUnpack(p0,"arch"); omega = pvUnpack(p0,"omega"); p = rows(garch); q = rows(arch);



Structures



u = d0.dataMatrix - b0; vc = moment(u,0)/rows(u); w = omega + (zeros(q,q) | shiftr((u.*ones(1,q))’, seqa(q-1,-1,q))) * arch; h = recserar(w,vc*ones(p,1),garch); logl = -0.5 * ((u.*u)./h + ln(2*pi) + ln(h)); retp(logl);
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Masked Matrices



The pvUnpack function unpacks parameters into matrices or arrays for use in computations. The first argument is a PV structure containing the parameter vector. Sometimes the matrix or vector is partly parameters to be estimated (that is, a parameter to be entered in the parameter vector) and partly fixed parameters. To distinguish between estimated and fixed parameters, an additional argument is used in the packing function called a “mask”, which is strictly conformable to the input matrix. Its elements are set to 1 for an estimated parameter and 0 for a fixed parameter. For example:



p0 = pvPackm(p0,.1*eye(3),"theta",eye(3));



Here just the diagonal of a 3×3 matrix is added to the parameter vector. When this matrix is unpacked, the entire matrix is returned with current values of the parameters on the diagonal:



print pvUnpack(p0,"theta");



0.1000 0.0000 0.0000 0.0000 0.1000 0.0000 0.0000 0.0000 0.1000



Symmetric Matrices



Symmetric matrices are a special case because even if the entire matrix is to be estimated, only the nonredundant portion is to be put into the parameter vector. Thus, for them there are special procedures. For example:
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Structures vc = { 1 .6 .4, .6 1 .2, .4 .2 1 }; p0 = pvPacks(p0,vc,"vc");



There is also a procedure for masking in case only a subset of the nonredundant elements are to be included in the parameter vector:



vc = { 1 .6 .4, .6 1 .2, .4 .2 1 }; mask = { 1 1 0, 1 1 0, 0 0 1 }; p0 = pvPacksm(p0,vc,"vc",mask);



Fast Unpacking



When unpacking matrices using a matrix name, pvUnpack has to make a search through a list of names, which is relatively time-consuming. This can be alleviated by using an index rather than a name in unpacking. To do this, though, requires using a special pack procedure that establishes the index:



Structures



p0 = pvPacki(p0,b0,"b0",1); p0 = pvPacki(p0,garch,"garch",2); p0 = pvPacki(p0,arch,"arch",3); p0 = pvPacki(p0,omega,"omega",4); Now they may be unpacked using the index number: b0 = pvUnpack(p0,1); garch = pvUnpack(p0,2); arch = pvUnpack(p0,3); omega = pvUnpack(p0,4);



When packed with an index number, they may be unpacked either by index or by name, but unpacking by index is faster.
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Miscellaneous PV Procedures



pvList



This procedure generates a list of the matrices or arrays packed into the structure:



p0 = pvPack(p0,b0,"b0"); p0 = pvPack(p0,garch,"garch"); p0 = pvPack(p0,arch,"arch"); p0 = pvPack(p0,omega,"omega"); print pvList(p0); b0 garch arch omega



pvLength



This procedure returns the length of the parameter vector:



print pvLength(p0); 6.0000



pvGetParNames



This procedure generates a list of parameter names:



print pvGetParNames(p0);
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Structures b0[1,1] garch[1,1] garch[2,1] arch[1,1] arch[2,1] omega[1,1]



pvGetParVector



This procedure returns the parameter vector itself: print pvGetParVector(p0); 1.0000 0.1000 0.1000 0.1000 0.1000 1.0000



pvPutParVector



This procedure replaces the parameter vector with the one in the argument: newp = { 1.5, .2, .2, .3, .3, .8 }; p0 = pvPutParVector(newp,p0); print pvGetParVector(p0); Structures



1.5000 0.2000 0.2000 0.3000 0.3000 0.8000
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GAUSS User Guide pvGetIndex This procedure returns the indices in the parameter vector of the parameters in a matrix. These indices are useful when setting linear constraints or bounds in sqpSolvemt. Bounds, for example, are set by specifying a K×2 matrix where K is the length of the parameter vector and the first column are the lower bounds and the second the upper bounds. To set the bounds for a particular parameter, then, requires knowing where that parameter is in the parameter vector. This information can be found using pvGetIndex. For example: // get indices of lambda parameters in parameter vector lind = pvGetIndex(par0,"lambda"); // set bounds constraint matrix to unconstrained default c0.bounds = ones(pvLength(par0),1).*(-1e250˜1e250); // set bounds for lambda parameters to be positive c0.bounds[lind,1] = zeros(rows(lind),1);



12.3.4



Control Structures



Another important class of structures is the “control” structure. Applications developed before structures were introduced into GAUSS typically handled some program specifications by the use of global variables which had some disadvantages, in particular, preventing the nesting of calls to procedures. Currently, the purposes served by global variables are now served by the use of a control structure. For example, for sqpSolvemt: struct sqpSolvemtControl { matrix A; matrix B; matrix C; matrix D; scalar eqProc; scalar ineqProc;
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Structures matrix scalar scalar scalar scalar scalar scalar scalar scalar scalar scalar scalar scalar matrix };



bounds; gradProc; hessProc; maxIters; dirTol; CovType; feasibleTest; maxTries; randRadius; trustRadius; seed; output; printIters; weights;



The members of this structure determine optional behaviors of sqpSolvemt.



12.4



sqpSolvemt



sqpSolvemt is a procedure in the GAUSS Run-Time Library that solves the general nonlinear programming problem using a Sequential Quadratic Programming descent method, that is, it solves



min f (θ)



Aθ = B Cθ>=D H(θ) = 0 G(θ)>=0 θlb 
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